LACI
Laboratory of Affective and Cognitive Imaging
Dr. Warren Taylor
# FreeSurfer QA Procedures

## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with XNAT</td>
<td>2</td>
</tr>
<tr>
<td>What is XNAT?</td>
<td>2</td>
</tr>
<tr>
<td>Getting Started</td>
<td>2</td>
</tr>
<tr>
<td>Navigating XNAT</td>
<td>4</td>
</tr>
<tr>
<td>Navigating to FreeSurfer Analysis Details</td>
<td>4</td>
</tr>
<tr>
<td>Navigational Hierarchy</td>
<td>8</td>
</tr>
<tr>
<td>Snapshot View</td>
<td>9</td>
</tr>
<tr>
<td>Status of Processed Data</td>
<td>10</td>
</tr>
<tr>
<td>QA Procedure</td>
<td>12</td>
</tr>
<tr>
<td>Creating a Search of Scans Requiring QA</td>
<td>12</td>
</tr>
<tr>
<td>Saving a New Search</td>
<td>16</td>
</tr>
<tr>
<td>Analyzing Scans Requiring QA</td>
<td>17</td>
</tr>
<tr>
<td>Excluded Brain</td>
<td>19</td>
</tr>
<tr>
<td>Non-Brain Included</td>
<td>20</td>
</tr>
<tr>
<td>Enlarged Ventricles</td>
<td>21</td>
</tr>
<tr>
<td>Mislabeled Structures</td>
<td>22</td>
</tr>
<tr>
<td>“Rerun” vs. “Failed-needs reprocessing”</td>
<td>23</td>
</tr>
<tr>
<td>Changing the Status</td>
<td>24</td>
</tr>
<tr>
<td>Downloading Files from XNAT</td>
<td>27</td>
</tr>
<tr>
<td>Downloading Files for Reprocessing</td>
<td>29</td>
</tr>
<tr>
<td>Tkmedit Overview</td>
<td>31</td>
</tr>
<tr>
<td>Freeview Overview</td>
<td>36</td>
</tr>
<tr>
<td>Editing Scans</td>
<td>46</td>
</tr>
<tr>
<td>Manually Selecting Control Points</td>
<td>47</td>
</tr>
<tr>
<td>Correcting Pial Surfaces</td>
<td>50</td>
</tr>
<tr>
<td>Fixing a Bad Skull Strip</td>
<td>55</td>
</tr>
<tr>
<td>Enlarged Ventricles</td>
<td>56</td>
</tr>
<tr>
<td>Masking Brainmask with Segmentation</td>
<td>57</td>
</tr>
<tr>
<td>Uploading Edited Files</td>
<td>58</td>
</tr>
</tbody>
</table>
Working with XNAT

Basic information about Vanderbilt’s XNAT can be found at xnat.vanderbilt.edu

What is XNAT?

XNAT is an open source imaging informatics platform developed by the Neuroinformatics Research Group at Washington University. It facilitates common management, productivity, and quality assurance tasks for imaging and associated data.

The primary tasks of XNAT include
- Uploading data
- Organizing and sharing data
- Viewing/downloading data
- Securing and managing access to data
- Searching and exploring large data sets
- Running complex processing on the data

This manual focuses on a workflow for using XNAT to inspect FreeSurfer outputs and apply any manual corrections.

Getting Started

The XNAT at Vanderbilt is accessed via a web browser at the URL: xnat.vanderbilt.edu/xnat

*Browsing to xnat.vanderbilt.edu without “/xnat” will take you to the Vanderbilt XNAT Wiki page which contains useful information about working with XNAT

Once on the XNAT site, you should see this login page:

If you are new to XNAT, register by clicking on the link and filling in the necessary information. A confirmation email will be sent to you with instructions on how to finalize your registration.

http://xnat.org/about/
If you already have an account, enter your username and password.

Navigating XNAT

Navigating to FreeSurfer Analysis Details
Once logged in, the home page of XNAT will look similar to this:

The “Projects” section of the Home Page lists all of the projects you can access. The Project ID, PI associated with the project, a short description of the project, and your listing of access level are listed under each project.

*User access levels include:
Collaborator: users with read-only access to data
Member: users with management permissions on the data (no access to the prearchive)
Owner: users with all permissions including delete
Choosing a project and clicking on it loads a window that looks like this:

By default, the project is organized by subject.

For our purposes, it is more convenient to view the project based on sessions. To do this, click on the drop down box that says “SELECT” and choose “MR SESSIONS”

This displays a list of MR Sessions for the project.
Listed is the **MR ID**, the **Date** on which the session took place, the **Subject** scanned during that session, and all of the **Scans** taken during the session.

For display details about a specific session, click on the specific MR ID. This opens a page that looks similar to this:
Note a few of the navigational aspects within the page:

Below the list of the Scans is a section called “Processing.”

### Processing

<table>
<thead>
<tr>
<th>Type</th>
<th>PDF</th>
<th>Proc Date</th>
<th>Proc ID</th>
<th>Job Status</th>
<th>QC Status</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>FreeSurfer</td>
<td><img src="image1.png" alt="Image" /></td>
<td>2013-09-14</td>
<td>CONTE-x-1033-x-c1033a3-x-FS</td>
<td>Needs QA</td>
<td>Show Counts</td>
<td></td>
</tr>
</tbody>
</table>

This is where the processed data are shown. The columns contain the following information:

- **Type** – The program responsible for processing the scan. In the example above, FreeSurfer processed the scan.
- **PDF** – By clicking on the PDF icon, users open a PDF file of summarized information about the processed data.
- **Proc ID** – Links to Analysis Details (see pg. 8 for more information).
- **Job status** and **QC Status** – Provide descriptions of the current status of the processed data (see pg. 10 for more information).
Clicking a FreeSurfer ProcID opens a page like this:

Navigational Hierarchy

As we see at the top of the page, we have built a navigational hierarchy.

PROJECT, CONTE > SUBJECT, 1853 > SESSION, e1853a3 > CONTE, x1853-x-c1853a3-x-FS

This hierarchy lists:

Clicking on any of the past hierarchical structures allows for easy navigation through the data.
View Snapshots

Toward the bottom of the FreeSurfer Analysis Details page you should see “View Snapshots.”

Clicking on this link opens up a new window which looks like this:

*Be patient in allowing this page to load. Depending on the network, it may take a few minutes.

The Snapshots page displays screenshots of scans FreeSurfer has processed. This page is integral in the QA procedure, so it is important to be able to navigate here.

- 2D axial, coronal, and sagittal slices are displayed.
- Slice number is displayed in the lower right corner of the image.
- The processed scan will appear on the left, and original on the right for comparison.
- Skip through the slices by clicking on the “Prev” and “Next” buttons or go directly to a slice by using the drop down option with slice numbers.
- Clicking on “Play” will quickly go through all screenshots.
- In the Snapshot view, only every fourth slice is available for viewing.
**Status of Processed Data**

There are two statuses for each Processing: Processing Job Status (procstatus) and QC status (QC status).

The **Processing Status** or **Job Status** lists the data’s current processing stage, i.e., whether FreeSurfer has finished processing the data or not.

The **QC Status** lists the data’s current QA processing stage. In other words, i.e. whether the data has been inspected, processed correctly or with errors, and whether it needs reprocessing or not.

---

### Types of Processing (Job) Statuses

#### Processing

<table>
<thead>
<tr>
<th>Type</th>
<th>PDF</th>
<th>Proc Date</th>
<th>Proc ID</th>
<th>Job Status</th>
<th>QC Status</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>FreeSurfer</td>
<td>![File Icon]</td>
<td>2013-09-14</td>
<td>CONTE-x-1033-x-c1033a3-x-FS</td>
<td>Needs QA</td>
<td>Needs QA</td>
<td>Show Counts</td>
</tr>
</tbody>
</table>

**NO_DATA**: Indicates that data necessary for FreeSurfer was not acquired for this session

**NEEDS_INPUT**: Indicates that data necessary for FreeSurfer to run is missing. For example, the DICOM image format has not yet been converted to NIFTI

**NEED_TO_RUN**: This status appears only for a few minutes after a scan first enters XNAT. It then automatically changes to “Job Running.” It’s also possible to stay on this status if there are many other jobs running

**JOB_RUNNING**: This appears for the entire duration of a scan’s processing by FreeSurfer. This step may take a few hours, but automatically switches to one of two options: “JOB_FAILED” or “COMPLETE.”

**JOB_FAILED**: This occurs if an external technical malfunction prematurely ends the processing of data. If such an event does occur, the scans need to be rerun.

**COMPLETE**: If the scan is processed with no interruption, this status appears. Only after a scan has a procstatus of COMPLETE should you move on to the QA procedure.
**QC Statuses**

**Processing**

<table>
<thead>
<tr>
<th>Type</th>
<th>PDF</th>
<th>Proc Date</th>
<th>Proc ID</th>
<th>Job Status</th>
<th>QC Status</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>FreeSurfer</td>
<td></td>
<td>2013-09-14</td>
<td>CONTE-x-1033-x-c1033a3-x-FS</td>
<td></td>
<td>Needs QA</td>
<td>Show Counts</td>
</tr>
</tbody>
</table>

**Needs QA:** This initial status appears when new scans are successfully processed by FreeSurfer. These data need to be inspected to determine if FreeSurfer correctly processed the data (the process for this is explained in a later section). Once the data has been determined to have been processed successfully or unsuccessfully, the status is then manually changed to either “Passed” or “Failed needs reproc.”

**Rerun:** This status is chosen if an obvious processing mistake occurred despite a “COMPLETE” ProcStatus listing. For example, if no images show up at all when viewing snapshots, a Rerun must be triggered. By changing the QC status to “Rerun,” the scans will be automatically reprocessed. The QC status then reverts to “Needs QA.”

**Passed:** A “Passed” status is listed if the QA procedure is completed and it is determined that FreeSurfer processed the data accurately and no edits were necessary.

**Failed needs reproc:** A “Failed need reproc” status is listed if the QA procedure is completed and it is determined that FreeSurfer inaccurately processed the scans. The guidelines for what constitutes an inaccurate processing by FreeSurfer is outlined in detail in a later section. These need to be manually edited and uploaded to XNAT.

**Passed with Edits:** This status is chosen after data run by FreeSurfer fails the QA procedure, is manually edited, then rerun and the result passes QA.

**Failed:** This status is chosen if a manual fix is not possible and the scans are deemed unusable. This may occur, for example, if movement in the scanner produced scans not fit to be analyzed.
Creating a Search of Scans Requiring QA

After becoming familiarized with the navigational aspects of XNAT, it is important to be able to organize all of the scans streaming-in to make the QA procedure quick and effective. This is done by creating “saved searches” in XNAT that organize scans based on “Status” (See the “Status of Processed Data” section for more information on pg. 11). Specifically, saved searches that show all scans from all projects that “Need QA” are especially helpful. There are a number of paths that achieve this, but only one method for creating this search is outlined below.


![XNAT interface](image)

This navigates to a page that looks like this:

![XNAT interface](image)

FreeSurfer processing for all projects are listed. To filter the available information, scroll all the way to the right and click on the dropdown box labeled “Options.”

![Dropdown options](image)

From the “Options” selection choices, choose “Edit Columns.”
This opens a window that allows viewers to select and deselect the columns that should appear.

By using the left/right arrows to add/remove columns and the up/down arrows to reorder the current fields, create a listing that looks like this:

```
Current Fields

Project (FreeSurfer)
Label (FreeSurfer)
FS_Date (FreeSurfer)
ScanDate (FreeSurfer)
processtatus (FreeSurfer)
QC_Status (FreeSurfer)
QC_Notes (FreeSurfer)
```

Submitting this returns a viewing page like this:
Notice the hierarchical structure in the label name and how it conforms to the navigational hierarchy previously mentioned (see “Navigational Hierarchy,” pg. 8).

Clicking on the label opens FreeSurfer processed data page.

Although data is now organized in a manageable manner, at this point all of the FreeSurfer processed data is available for viewing.

To filter the status, click on the “QC_Status” bar.

From the options, choose “Filter.”

This returns a window that looks like this:
From the “Select” drop down options, choose “=.”

This returns another “Select” option. Choose “Needs QA.”

Click submit to load the viewing page. Only data requiring QA is then shown.

Now the search simply needs to be saved so that it can be viewed any time without going through the above process.
Saving a New Search

Once search parameters are arranged in an accessible manner, the search can be “saved as a new search.” This allows the user to access the search at any time once logged into his or her account. Saved searches are dynamic, so any new data matching the search criteria is automatically updated.

Once a search is properly arranged, saving it is very easy.

First, click on the options button at the right-hand side of the page.

From the options, choose “Save as a New Search.”

Following the example in which a search of scans needing QA was created (pg. 12), save the search as “FreeSurfer_Needs QA.”

The new search appears in the home screen under “Stored Searches.”
Analyzing Scans Requiring QA

**This section represents potential problems with FreeSurfer results and how to identify them. Corrections for these problems are explained in a later section of the procedure.**

After creating quick and easy access to scans, the next step involves marking processed data as either “Passed” or “Failed needs reproc” (pg. 10). To do this, click on the saved Saved Search of scans needing QA (or simply to any processed data that is marked as needing QA) on the XNAT homepage. Click the link under the “Label” section of the Saved Search to open FreeSurfer Analysis Details. From here, go to the “View Snapshots” link (pg. 9).

The “View Snapshots” page is where the FreeSurfer results may be judged as having successfully processed a scan or not. There are a number of important things to look for when doing this.

With many scans, the problem will often be seen in the outline of the brain. FreeSurfer shows this with the red and yellow lines. The red lines represent the pial surface, or the surface representing the boundary between gray matter and cerebrospinal fluid. The yellow lines represent the white/gray matter surface.

When going through the snapshots of the processed data, it is important to look carefully at where these lines appear in comparison to the original scan. With geriatric brains, it is common for FreeSurfer to exclude parts of the brain that should be there, or to include parts that should not.

**Axial, coronal, and sagittal slices should all be inspected carefully.**

FreeSurfer also segments subcortical areas and shows each area highlighted by a different color. It is also important to look at these segmentations for any signs of obvious problems. Examples of this can be seen on pg. 22.
The following chart will help in recognizing which colors represent which structures when looking at the snapshot view.

There are regions where the surfaces are not intended to be accurate that you should be aware of:

- Areas around the hippocampus and amygdala - The surfaces will not completely include or exclude certain subcortical regions. These inaccuracies can be ignored as subcortical regions are excluded from the cortical measures and subcortical volume is measured by the aseg, not the surfaces.
- Along the midline cut - It is possible to see some overlapping of the surfaces from one hemisphere to another. The medial wall is not included in the cortical measures so this can generally be ignored.
Excluded Brain

The above axial slice represents a processed image that excludes a part of the cortex.

Looking closely, the pial surface draws the boundary inside the actual boundary of gray matter:

This warrants a “Failed needs reproc” status.

*Keep in mind that a problem may be seen in only one slice of the snapshots, so it is important to look at each slice in each view carefully.*
Non-Brain Included

Here is an axial slice that is a drastic example of a processed image that has included non-brain areas as brain areas.

More closely:

This also warrants a “Failed need reproc” status.

Not all examples of non-included brain are this dramatic, so it is important to give careful attention to the gray matter outline.
Enlarged Ventricles

Another processing error involves brains with enlarged ventricles. When ventricles are enlarged, FreeSurfer might not recognize the ventricles.

Properly processed ventricles will appear in purple:

![Properly Processed Ventricles](image1.png)

Enlarged ventricles often appear as such:

![Enlarged Ventricles](image2.png)

The ventricles showing up in black, along with the incorrectly drawn pial and white matter surfaces, are inaccurately processed images. These scans should be marked as “Failed needs reproc.”
Mislabeled Structures

FreeSurfer may also mislabel structures. For example, processed images color the cerebellum in orange (it may be useful to refer back to the chart presented in the “Analyzing Scans Needing QA” section on pg. 18).

Images such as the one below have been inaccurately processed when considering FreeSurfer’s orange highlighting of the cerebellum and having a general knowledge of what the cerebellum looks like.

The cerebellum is not properly segmented. Referring to properly segmented images from other sessions, the cerebellum highlighting should look more like this:

Mislabeled structures warrant a status of “Failed – needs reproc.” Describe which structure is mislabeled in the Notes section.
“Rerun” vs. “Failed-needs reproc”

It is important to distinguish between statuses of “Rerun” and “Failed-needs reprocessing”.

Keep in mind that changing a status to “Rerun” automatically causes the XNAT system to process the original scans again, whereas a “Failed needs reproc” status simply identifies that the process was completed but requires manual edits because of certain issues.

Rerunning a scan does not fix any of the problems listed in the previous sections (such as excluded brain, enlarged ventricles, etc.)

The “Rerun” status should only be used for technical errors that seem to be a result of a problem in the processing system.

For example, if when viewing snapshots the window does not show the images:

![Image of snapshot view](image)

Or if the original scan is cut out in the snapshot view:

![Image of brain scan](image)

Rerunning should be done to see if the problem stems from a processing error.

An easy way to think about it is whether a manual edit could solve the issue. For example, if none of the images of the brain show up, FreeSurfer’s labeling of brain parts cannot be manually changed (because there is no brain to change!). In those cases, the data should be rerun.

By changing the QC status to “Rerun,” the scans will be automatically rerun and reprocessed. After reprocessing, the QC status will revert back to “Needs QA.”
Changing the Status

After checking FreeSurfer processed scans, the status of the data needs to change from Needs QA to either Passed or Failed needs reproc

Changing from Needs QA to Failed needs reproc

For example, this scan needs QA. Coronal slice 089 looks like this:

![Coronal slice 089](image)

This scan is processed incorrectly because it labels non-brain areas as part of the brain.

To change the status to Failed needs reproc, on the FreeSurfer analysis page, click Edit in the Actions box

![Freesurfer Analysis Details](image)

In the window that opens, fill in the necessary information.

![Freesurfer Details](image)

The Status changes to Failed-needs reprocessing. In the Notes section, explain what the problem is, the general area of where the problem occurs, and an example of a slice in which the problem can clearly be seen.
Include details on what is wrong with a scan in the Notes section. For example, consider the following coronal and sagittal slices:

Using location information from both images, it should be noted in the notes section that a large portion of the right occipital lobe is missing. This will help locate the problem when returning to fix it.

**Changing to any other status**

When changing the status from *Needs QA* to *Passed*, *Rerun*, etc., simply go to the *Edits* section of the FreeSurfer Analysis page to change the status.
If the status is changed to **Rerun**, the scans will be automatically rerun and reprocessed. The QC status will then revert back to **Needs QA**.
General Information about Fixing Scans:

The following sections of the procedure deal with fixing scans that have been marked as Failed – needs reproc.

The procedure is written from a Windows computer set-up with Ubuntu running on VirtualBox. It is important to note that the following steps cannot be done on a Windows PC. The FreeSurfer tools require Linux or Mac OSX.

Downloading Files from XNAT

The preferred way of downloading files for fixing is outlined in the next section (Downloading Files for Reprocessing; pg. 29). This is a reference for an alternative method.

Once scans are labeled as needing reprocessing, they must be downloaded locally before they can be fixed. One way to do this is to download them directly from XNAT. Although this may not be the fastest route, it is good to know.

To download the file, first go to the Session view page of the scan you are looking to download (pg. 7).

Once on this page, click on Manage Files

This will pull up a file manager window that allows you to choose what files you would like to download. Uncheck all the files, and scroll down to the section that says “assessors” and below it “FreeSurfer.”
From these, check only the files listed under “DATA”

Then just click Download

After downloading, the file may be buried deep in the computer’s folders. Be sure to find the correct file when using it and opening it with the viewer.

Make sure that the subject folder is the folder that gets put into the `/opt/freesurfer/subjects` folder. The subject folder is the one that holds the following:

The file folder containing the label, mri, scripts, stats, surf, and touch folders needs to be placed into `/opt/freesurfer/subjects`

*Keep in mind that this is not the preferred way to download files. A faster and more streamlined way is outlined in the next section (Downloading Files for Reprocessing; pg. 29).*

**Downloading Files for Reprocessing**
The preferred way of downloading files is a more streamlined command line.

Take, for example, this scan that needs to be downloaded and edited (since it was labeled as needing reprocessing):

To download it, first go to the computer through which the editing will take place. It is necessary to communicate with the operating system through a “shell” or terminal window. In this case, we go to Ubuntu and open the terminal window.

*Important: The below command line (as well as the shorthand upload command line introduced later) will only work if the computer has the proper script available.*

The command we will run looks like:

```
fsdownload <project> <MRsession>
```

In the above example, the `<project>` is VAD2 and the `<MRsession>` is 318c. So the command will look like:

```
kudra@ned:~$ fsdownload VAD2 318c
```

The files will then download and move to the specified location. This step may take a few minutes.

To see the folder, go to the Home Folder, then to File System, and from there to `/opt/freesurfer/subjects`. 
The scans cannot be opened just by clicking on the icon. A command needs to be entered to open the FreeSurfer tool tkmedit or Freeview to view and edit the processed images. This is explained in the next sections.

Tkmedit Overview
**IMPORTANT:** Tkmedit was the go-to viewer for editing problematic FreeSurfer output. However, the new tool is Freeview, and the Freeview Overview is available in the next section. However, tkmedit can still be used to edit/view scans. Although either/or can be used, only Freeview will be explained in detail for specific manual edits.

The following is an edited version of a tutorial taken from
[http://freesurfer.net/fswiki/FsTutorial/OutputData](http://freesurfer.net/fswiki/FsTutorial/OutputData) on 10/31/13

### Viewing Volumes with Tkmedit

Output volumes can be loaded into tkmedit, along with surface outlines and the subcortical segmentation. With one command line, you can load in the brainmask.mgz and wm.mgz volumes, the rh.white and lh.white surfaces (outlines), and the subcortical segmentation. Copy and paste the command below inside the terminal window:

```bash
tkmedit <subject> brainmask.mgz -aux T1.mgz -surfs -aseg
```

Some notes on the above command line:

- `<subject>`: name of subject
- `brainmask.mgz`: skull-stripped volume primarily used for troubleshooting
- `-aux T1.mgz`: pre-skull-stripped volume loaded as 2nd volume
- `-surfs`: loads all surfaces (orig, white, and pial, for left and right hemispheres)
- `-aseg`: loads automatic volume segmentation called aseg.mgz

You should see a tkmedit window open:

(usage the zoom and move buttons to clearly see the entire image)

You are currently looking at the brainmask.mgz with the surfaces displayed and the aseg.mgz (subcortical segmentation) overlayed. The pial (red line), and white (yellow line) surfaces are shown. You can toggle between the brainmask.mgz
(loaded as the "main" volume) and the T1.mgz (loaded as the "auxiliary" or 2nd volume) with buttons and . As you switch between these two buttons, notice that at the top of the display window, the asterisks (**) surround the name of the volume you are currently looking at.

- **Keyboard Shortcut:** Alt-c will allow you to quickly switch back and forth between the two volumes instead of clicking between these buttons.

If you hover your mouse over a button in the Tkmedit Tools window, a pop-up will tell you what it does and its keyboard shortcut. When the Navigation button is chosen, you can drag the brain around in the display window. Try it out.

Notice how you are not able to move around the cursor (the little red cross-hair).

- To change the location of the cursor, choose any button to the right of the Navigation button and then left-click in the display window. Notice the cursor move to wherever you click. When you zoom, it will zoom into the location of the cursor. When you change brain orientation (to axial or sagittal), you will be viewing the slice where the cursor was located in that plane.

To change which brain slice you are viewing, you can use the + or - buttons next to where it says "Slice".

- **Keyboard Shortcut:** Use the Up or Down arrows on your keyboard to change slices faster (this will only work when the Display window is selected and not on the Tools window).
Checking the Surfaces in tkmedit

Toggle to the brainmask volume, if not already in view, by using the button or Alt-c. The white surface (yellow line) is used to calculate total white matter volume and should accurately follow the boundary between white matter and gray matter. The pial surface is used to calculate cortical gray matter volume and should accurately follow the boundary between the gray matter and the CSF.

Tip: It may be easier to concentrate on the surfaces if you toggle off the aseg with the button.

- **Keyboard Shortcut:** Ctrl-g will also turn off the aseg.

As you scroll through the slices checking the surfaces, keep in mind that you are looking at a 2-dimensional rendering of a 3-dimensional image - be sure to look at more than just one view (i.e., sagittal, coronal and horizontal). To check your surfaces, toggle them off and on with for the pial surface and for the white surface. Would you draw the boundary in the same location? Adjust the brightness and contrast so you can see the shift in intensity between gray and white. You can do this by going to View > Configure > Brightness/Contrast in the Tkmedit Tools window and then moving the sliders to adjust the levels.

- **Keyboard Shortcuts:** You can also use Ctrl-p and Ctrl-m to turn on and off the pial and white surfaces.
- If the Tkmedit Tools window is highlighted, Ctrl+b will open the Brightness/Contrast window. Alternatively, you can hold down the shift button and drag the left mouse button in the display window and this will change the brightness/contrast without using the sliders.

There are regions where the surfaces are not intended to be accurate that you should be aware of:

- Areas around the hippocampus and amygdala. The surfaces will not completely include or exclude certain subcortical regions. These inaccuracies can be ignored as subcortical regions are excluded from the cortical measures and subcortical volume is measured by the aseg, not the surfaces.
  - For an example of this, see coronal slice 137 (enter 137 into the box next to where it says "Slice" and hit enter).
- Along the midline cut, it is possible to see some overlapping of the surfaces from one hemisphere to another. The medial wall is not included in the cortical measures so this can generally be ignored.
Subcortical Segmentation

Toggle on the subcortical segmentation with the button or Ctrl-g. This will show the complete segmentation of the subcortical structures. Each structure is labeled with a unique color/number distinction. If you click on a voxel the structures name and number label will be shown in the Tkmedit Tools window (under where it says "Cursor"). Toggle the aseg on and off to make sure the aseg is accurately following the underlying intensity boundaries of each structure. Scrolling through the slices you will be able to see if everything is labeled, and done so accurately. Sometimes it is easier to see the structures and their boundaries looking in either the sagittal or horizontal view, so be sure to check around in all of them. If you hold down the Ctrl button and left click on the button, a window will pop up that will allow you to adjust the segmentation opacity.

Aparc+Aseg segmentation

To load the aparc+aseg segmentation you can go to File > Load Segmentation and browse to the aparc+aseg.mgz. Hit OK once you have selected the file and then OK again in the Load Segmentation window. When loaded, it will look like this:

This segmentation shows the same subcortical structures that are labeled in the aseg.mgz, but also displays the cortical parcellation labels in the volume. Click around the cortex to see the name of each cortical region in the Tools window.
Skull Strip

Turn off the segmentation (Ctrl-g) and scroll through the brainmask volume. Notice that there is no skull left in your image. Notice also that the cerebellum is still included in the volume. You should not see any large areas of skull left behind, or any areas of cortex or cerebellum removed from this volume. You can toggle between the brainmask.mgz volume and the non-skull-stripped, T1.mgz volume using Alt-c to ensure that the skullstrip has worked properly.

Intensity Normalization

Scroll through the brainmask volume and notice that the intensity is all uniform. You should not see any very bright or very dark spots in the white matter or gray matter. If you click on a voxel in the white matter, you can see that it has been normalized to an intensity of (or very close to) 110 in the Tkmedit Tools Window (under Cursor, next to where it says "brainmask.mgz val"). When wm voxels are not close to 110, they may be erroneously excluded from the white surface.

WM Volume

To check the wm volume you should load it in as a new aux volume. To do this go to File > Aux Volume > Load Aux Volume and browse to wm.mgz. This should open:

![Screenshot of Tkmedit window showing brainmask volume.

This volume is FreeSurfer's initial segmentation of the white matter (shown in shades of gray) with additions from the automatic topology fixer (in white). This "mask" is the starting point for the white surface which grows out from here and stops at a more accurate location along the wm/gm boundary using the intensity gradients in the brainmask.mgz volume as a guide. The wm.mgz can be used to add missing wm voxels or delete voxels that are not wm but were included in the surface.

You can close Tkmedit by hitting the X on the display window. You can also use Ctrl-q to close it.
Freeview Overview

**IMPORTANT:** Tkmedit was the go-to viewer for editing problematic FreeSurfer output. However, the newest updated choice is Freeview. Although either/or can be used, only Freeview will be explained in detail for specific manual edits.

The following is an edited version of a tutorial taken from [http://freesurfer.net/fswiki/FsTutorial/OutputData_freeview](http://freesurfer.net/fswiki/FsTutorial/OutputData_freeview) on 11/07/13

Viewing Volumes with Freeview

With one Freeview command line, you can load several output volumes, such as brainmask.mgz and wm.mgz; the surfaces, rh.white and lh.white; and the subcortical segmentation, aseg.mgz. Copy and paste the command below inside the terminal window and press enter:

```bash
freeview -v
  good_output/mri/T1.mgz
  good_output/mri/wm.mgz
  good_output/mri/brainmask.mgz
  good_output/mri/aseg.mgz:colormap=lut:opacity=0.2
  -f good_output/surf/lh.white:edgecolor=blue
  good_output/surf/lh.pial:edgecolor=red
  good_output/surf/rh.white:edgecolor=blue
  good_output/surf/rh.pial:edgecolor=red
```

Some notes on the above command line:

- **good_output**: the name of the subject
- The flag -v is used to open volumes
  - **brainmask.mgz**: skull-stripped volume primarily used for troubleshooting
  - **wm.mgz**: white matter mask also used for troubleshooting
- **aseg.mgz**: subcortical segmentation loaded with its corresponding color table and at a low opacity
- The flag -f is used to load surfaces
  - **white & pial surfaces** are loaded for each hemisphere & with color indicated by 'edgecolor'

Note that if this error appears when trying to load a scan, you need to change the file directory you are in with a command.
For example, if the subject folders are in /opt/freesurfer/subjects, you first need to type the command

```
cd /opt/freesurfer/subjects
```

The menu on the left shows which files have been loaded.
Use the buttons at the top to change which orthogonal view appears in the main viewing window.

You can also use the buttons to change the organization of the viewing panes. To change which brain slice you are viewing, use the 'Page Up' or 'Page Down' keys on your keyboard. (Mac users: press the fn key while using the up and down arrows.)

While Freeview can load many volumes at once, you cannot necessarily see them all at once. You are able to see whichever volume is at the top of the list in the menu on the left. An exception to this are volumes such as the wm.mgz and aseg.mz which can be made translucent, allowing you to view the information they contain simultaneously with the volume directly below it on the list. For example, the image below displays information from both the aseg (labeled structures) and the brainmask (voxel intensities).

You can hide or turn off a layer by unchecking the check box next to the layer name. You can also use the up and down arrows (located below the menu on the left) to move the aseg down on the list, below the brainmask. If you double click on the name of any volume in the list, it should automatically move to the top. The menu should now look like this:
- **Keyboard Shortcut**: Alt+c will allow you to quickly cycle through all the layers. Every time you hit it, the volume at the top of the list will move to the bottom of the list.

When the Navigation button is chosen, you can move the image in the viewing window around by holding down the middle mouse button and dragging the mouse where you want the image to go. You can also move the image more slowly using the up/down and left/right keys.

To zoom, scroll with the middle mouse button. In this navigation mode, notice the cursor (little red crosshair) moves to wherever you left click. When you change the orientation (to axial or sagittal), you will be viewing the slice that intersects with the cursor's location. To illustrate this point, if you are in the viewing pane selected here:

You'll notice all the planes will shift based on where you move the cursor.

One other important thing to note is that any action you do in the viewing window (i.e. erasing, changing brightness, etc.) will take place on whichever volume is currently highlighted in the left menu, regardless of which file is at the top of the list.
Checking the Surfaces

Double click on 'brainmask' in the left menu to bring it to the top of the volume list. The white surface (blue line) is used to calculate total white matter volume and should accurately follow the boundary between white matter and gray matter. The pial surface is used to calculate cortical gray matter volume and should accurately follow the boundary between the gray matter and the CSF.

As you scroll through the slices checking the surfaces for accuracy, keep in mind that you are looking at a 2-dimensional rendering of a 3-dimensional image - be sure to look at more than just one view (i.e., sagittal, coronal and horizontal). You can turn the surfaces off and on by checking and unchecking them in the left menu under where it says 'Surfaces'. As you do this, ask yourself: would you draw the boundary in the same location?

- **Keyboard Shortcut**: Alt+f will turn on and off whichever surface is highlighted in the menu window.

To help verify accuracy, adjust the brightness and contrast so you can easily identify the shift in intensity between gray and white matter. To do this, left click on the image while holding down the 'Shift' key and drag your mouse. (Make sure the brainmask volume is highlighted in the left menu in order for this to work.) The other way to do this is via the 'Window' and 'Level' sliders underneath the left menu.

**There are regions where the surfaces are not intended to be accurate that you should be aware of:**

- Areas around the hippocampus and amygdala. The surfaces will not completely include or exclude certain subcortical regions. These inaccuracies can be ignored as subcortical regions are excluded from the cortical measures and subcortical volume is measured by the aseg, not the surfaces.
- Along the midline cut, it is possible to see some overlapping of the surfaces from one hemisphere to another. The medial wall is not included in the cortical measures so this can generally be ignored.
Subcortical Segmentation

Double click on the aseg so it is directly above the brainmask in the left menu.

This will show the complete segmentation of the subcortical structures.

Each structure is labeled with a unique color/number distinction. If you click on a voxel the structure's name and number label will be shown in the 'Cursor' section under the viewing window next to the word, 'aseg'.

If you hover over a voxel where the cursor is not located, the value of that voxel will appear under the 'Mouse' section.
• **Keyboard Shortcut**: Alt+v will turn on and off the layer that is currently highlighted.

Make sure 'aseg' is highlighted in the left menu and press Alt+v to turn it off and on. While doing this, make sure the aseg is accurately following the underlying intensity boundaries of each structure. You can also adjust the 'Opacity' slider to better see the underlying brainmask.

![Image showing the 'Opacity' setting and its slider]

• **Keyboard Shortcut**: Alt+a and Alt+s will change the opacity of the layer that is currently highlighted.
Aparc+Aseg segmentation

First, close the aseg volume by highlighting it and the clicking this button 
. Then, to load the aparc+aseg segmentation go to File > Load Volume, click on the yellow folder icon, and browse to the aparc+aseg.mgz. Once you have selected the file, click 'Open', and then 'Ok'. When it loads, 'Grayscale' will be selected as the Colormap. This will obscure the brainmask beneath. In the Color map section on the left, choose 'Lookup Table'. Then adjust the opacity so that you can see the brainmask and aparc+aseg at the same time. When loaded, it will look like this:

This volume shows the parcellated cortical ribbon at the same time as the segmented subcortical structures. Click around the cortex to see the name of each cortical region under the 'Cursor' section. The aparc+aseg.mgz uses the Desikan-Killiany atlas. To see the Destrieux atlas, you would load the aparc.a2009s+aseg.mgz
Skull Strip

Close the aparc+aseg. As you scroll through the brainmask volume, notice that there is no skull left in your image. You should also not see any regions of cortex or cerebellum missing from this volume. Bring the T1.mgz to the top of the volume list and toggle between it and the brainmask.mgz volume (Alt+v) to verify that the skullstrip has worked properly.

Intensity Normalization

Scroll through the brainmask volume and notice that the intensity is all uniform. You should not see any very bright or very dark spots in the white matter or gray matter. If you click on a voxel in the white matter, you can see that it has been normalized to an intensity of (or very close to) 110 (look under the Cursor section next to where it says ‘brainmask’). When wm voxels are far from a value of 110, they may be erroneously excluded from the white surface.

White matter should be normalized to around 110
WM Volume

Double click on the wm volume to bring it to the top of the list. This volume is FreeSurfer's initial segmentation of the white matter (shown in gray) with additions from the automatic topology fixer (in white). This "mask" is the starting point for the white surface which grows out from here and stops at a more accurate location using the intensity gradients in the brainmask.mgz volume as a guide. The wm.mgz can be used to add missing wm voxels or delete voxels that are not white matter but were included in the surface.

For now, it will be good to learn how to change the wm mask to a heat overlay for ease of editing. With wm highlighted in the left menu, take a look at the options next to Color Map and choose 'Heat' or 'Jet'. Then adjust the opacity so you can also see the brainmask underneath (down to around .25).

![WM Volume Image]

It should look like this:

This could have also be done via commandline when first loading the wm in Freeview if we used this command: `freeview -v wm.mgz:colormap=heat:opacity=0.25 brainmask.mgz` (Note: You don't need to run this command.)

You can now close Freeview by hitting the X on the display window or Ctrl-q.
Editing Scans
The “Analyzing Scans Needing QA” section (pg. 17) identified four broad reoccurring problems that may arise when looking at processed data. The following section takes each and identifies a method for fixing the problem.

The following sections are edited versions of a tutorial taken from http://freesurfer.net/fswiki/FsTutorial/TroubleshootingData on 11/08/13

Excluded Brain

The above axial slice represents a processed image that excludes a part of the cortex.

Looking closely, we can see that the yellow lines that are supposed to outline the white matter are incorrect. FreeSurfer has not properly normalized the intensity of white matter.

This can be fixed by using control points to show Freesurfer what parts of white matter it has missed.

Sometimes the intensity normalization step will fail because it cannot determine the proper intensity for white matter. The result is an erroneous white matter segmentation. A control point is a manually selected location in the volume that the user feels sure is inside the white matter boundary, and subsequently should be normalized to an intensity of 110. As you move your mouse around the menu, the value next to T1 and Brainmask should change, it should be 110 when it is hovering over white matter.
Manually Selecting Control Points

Scroll through this subject and find the location where the white matter is being excluded from the surface.

To add control points, you need to click on the "Point Sets" tab to the right of the volume tab.
Then click the "New Point Set" tab and name the set "control.dat" make sure the control points option is selected. It should look like this:

Make sure the reference is either the brainmask.mgz or T1.mgz and click "Ok." Use your left mouse button to click where you want to add control points on the volume. Holding down shift while clicking again on a control point will delete it.

As you add control points, they will appear as small bright green dots. You can adjust the radius to be smaller if you like. Select a few control points around your trouble areas, space them out throughout the brain and on different slices. You want to pick points in a region where the wm intensity is lower than it should be (that is, having a voxel value less than 110).
General tips for adding control points:

- Control points should only be added in regions that are definitely white matter (i.e., not in the cortex, cerebellum, brainstem, or outside of the skull).
- Control points should also only be added in regions where voxel intensity is not 110. A control point in a region that is already normalized to 110 will be useless.
- Control points should NOT be used to try and normalize a brain lesion to 110. Such defects should be fixed with white matter edits.
- Control points can help recover thin white matter strands that are dark by putting some at the base of the strand.
- Control points are also useful in areas of very bright intensity.
- Start off with a few control points spread out in your trouble area. You may need to add more. With experience you will be able to determine how many are appropriate, given your specific subject.

Here is an example of one slice with the control points added. **Note that there are other control points spread out through other slices as well.**

![Control Points Example](image)

After adding control points, click on the "save point set" button.

Go to **File-> Save point set.**

![Save Point Set Button](image)

Make sure to save the point set within `<subject name>/tmp/control.dat`.

If the “tmp” folder does not exist with the subject folder, you must create one first.
Correcting Pial Surfaces

The pial surface is created by expanding the white matter surface so that it closely follows the gray-CSF intensity gradient as found in the brainmask.mgz volume. Once an accurate white surface is created then you can work on correcting the pial surface, if needed. The pial surface boundary and white matter surface boundary should not cross. After the pial surface has been generated, it’s a good idea to visually check it for defects that may have been created during automatic topology fixing. To check the pial surface, it may be loaded into freeview and viewed along with the brainmask.mgz volume. If the surface appears not to follow the gray-CSF boundary in the volume, edits may be required.

Editing the Volume

Use the PageUp and PageDown keys to go through the volume slice by slice (Fn+Command+Up/Down on Mac), and view the pial surface (red line) and white matter surface (yellow line). Notice the bright diagonal line in the slice below that has caused the pial surface to expand past the actual pial boundary. This is the result of a bad segmentation incorporating a piece of the dura within the pial surface.

To fix this type of error you can simply edit away the offending voxels from the brainmask.mgz volume.
To do this you will need to click on the **Recon Edit** button which will bring up this window:

- **First**, set the brush to a size comfortable for you. A brush size of 2 works well for this edit.
- **The **Recon editing** mode is already selected for you as indicated by the checkmark in the corresponding checkbox. In **Recon editing** mode the brush value and eraser value are set to 255 and 1, respectively. Make sure the first option, **Freehand**, at the top-left, is selected and you're ready to make your edits.
- **Find** a place in the image where the dura is causing errors in the segmentation.
- **Double check** that the brainmask.mgz (not the T1.mgz) is selected and highlighted in the side panel listing all the volumes. **You only want to make edits to the brainmask.**
- **Hold down** the **Shift** key and use the left mouse button to delete the voxels. It is not necessary to completely remove the dura to get an adequate pial surface, but it is good to do so until you are more familiar with manual editing.
The earlier image of the bad segmentation would look like this after the edits were made:

- Continue on to the other slices until the dura is removed.
- Ctrl-Z and the Undo button at the top in freeview allows you to go back and undo as many edits as you like.

At any time, you can save the changes you've made to the brainmask.mgz volume by selecting **Save Volume** in the freeview **File** menu or by clicking the **Save Volume** button.

**When saving, save the edited brainmask as** `brainmask.edited.mgz`

Make sure the brainmask is the one highlighted while saving if you have the T1 open at the same time.
Edits to correct pial surface extension into cerebellum

The brain.finalsurfs.manedit.mgz volume will allow for the correction of a particular type of problem involving pial surface misplacement whereby parts of the pial surface have extended into the cerebellum in certain areas. It is only in this case where the pial surface extends into cerebellum where the brain.finalsurfs.manedit.mgz volume should be edited. For all other non-cerebellum pial surface problems, brainmask.mgz should be edited. This cerebellum / pial surface problem can be fixed by removing those cerebellum voxels and other surrounding problematic voxels in the brain.finalsurfs.manedit.mgz volume such that upon running recon-all, the pial surface will be pulled in as desired, bordering only gray matter/ CSF boundary, and not jutting into the cerebellum. If only edits to this volume are made on a subject, it is sufficient to re-run recon-all from the point of these edits using the flag -autorecon3. Note that you must create brain.finalsurfs.manedit.mgz by copying it from brain.finalsurfs.mgz:

cd <subj>/mri
cp brain.finalsurfs.mgz brain.finalsurfs.manedit.mgz
Fixing a bad skull strip

Occasionally, the skull stripping step either removes more than just the skull, causing part of the brain to be removed as well, or too little, leaving behind portions of the skull. Both of these problems need to be corrected before continuing to the next step, either by manually editing the volumes or by adjusting input parameters to the skull stripping step, and running the skull strip again until a good result is obtained. Often the sagittal view reveals skull strip failures.

Below, the first picture is missing the right hemisphere of the cerebellum, and the second picture shows that it is present in the T1.mgz volume.

In general there are two ways to fix a volume when there is something missing from the cortex or cerebellum: you can clone the missing pieces in manually or you can adjust the parameters of mri_watershed to do it automatically. For this case, because there is a lot missing on so many slices, you should adjust the parameters of mri_watershed.
Adjusting watershed parameters

The watershed algorithm is used during the skull stripping step to find a boundary between the brain and skull. The mri_watershed program uses a default preflooding height of 25 percent.

- If we want the algorithm to be more conservative (i.e. if part of the brain has been removed), you will want to make that number larger than 25.
- If you want the algorithm to be more aggressive (i.e. part of the skull has been left behind), you will want to make the height less than 25.

There aren't any hard and fast rules about how to select your height value. You can adjust the preflooding height by passing the following flag to recon-all:

```
recon-all -skullstrip -wthresh <h> -clean-bm -subj <subject name>
```

where `<h>` is replaced with the preflooding height you'd like to use and `<subject name>` is replaced with your subject.

The clean-bm flag is used to instruct recon-all to write over the old brainmask.mgz volume with your new edits. If you do not use this flag your changes will not take effect.

Part of the brain is missing

Now we will take another look at the first volume we looked at, where part of the cerebellum had been removed. If you suspect that certain anatomy could be an outlier, and may be responsible for making the skullstripping step fail or produce poor results, then you can try using the -no-wsgcaatlas flag (wsgcaatlas = with skull gaussian classifier array atlas). You can adjust the watershed threshold by passing the -wthresh flag to recon-all. In this instance, since too much was removed, we want to raise the watershed threshold so use the command:

```
recon-all -skullstrip -wthresh 35 -clean-bm -no-wsgcaatlas -subj <subject name>
```

Take a look at your output volume (brainmask.mgz has been changed) along with the original T1 volume (T1.mgz), and verify the result of the new skull stripping is correct.

It should look like this:
Using gcut

When the skull stripping has left a small part of dura left, it is quicker to try and rerun the skullstrip step using the -gcut flag than to do manual editing. This flag removes any extra dura that could influence the surfaces.

```
recon-all -skullstrip -clean-bm -gcut -subj <subjid>
```

*INFO:* Care must be taken to thoroughly inspect your data when using -gcut. In particular, inspect the edges of gm and cerebellum for over-aggressive cutting. Open the brainmask.gcuts.mgz volume in freeview to view the voxels which gcut has removed. We recommend viewing the brainmask.gcuts.mgz overlayed on the T1.mgz to clearly see which voxels have been removed by gcut.

![Image of brain with gcuts highlighted]

Use talairach_with_skull_2.lta

During the skull-strip stage, the registration file talairach_with_skull.lta is created by mri_em_register in order to make use of the atlas to find skull. But in the autorecon2 stage, the registration file talairach_with_skull_2.lta is created, and this one is created with the benefit of the mri_ca_register stage, and so tends to be a tiny bit more accurate than talairach_with_skull.lta, and so it is possible that the skull-strip will work better with this registration file. So to make use of it:

```
cd $SUBJECTS_DIR/yoursubj/mri/transforms
cp talairach_with_skull.lta bak
cp talairach_with_skull_2.lta talairach_with_skull.lta
cd $SUBJECTS_DIR/yoursubj/mri/transforms
recon-all -s yoursubj -skullstrip -clean-bm -clean-lta
```

Inspect the brainmask.mgz after this completes.

Enlarged Ventricles

The best fix for a scan that has mislabeled ventricles because they were enlarged is a -bigventricles flag passed into the autorecon2 stage.

If you don’t know how to do this, have Brian (the analyst/programmer) do it.
Masking Brainmask with Segmentation

Sometimes when a lot of skull is left in a scan, even if it is not included in the original gray/white matter boundaries, a second run may cause Freeview to mistake previously ignored parts as gray or white matter.

For example, take this original scan:

![Original Scan](image)

With the manual voxel edit, the brainmask looks like:

![Brainmask with Manual Edit](image)

However, after reprocessing, the scan came out as:

![Reprocessed Scan](image)
To remedy this, the manually edited scan can be then masked by the segmentation to completely remove the left over skull from the brain mask. This is done through a command in the terminal window.

The command:

```plaintext
mri_mask brainmask.mgz aparc+asag.mgz brainmask.edited.mgz
```

The brainmask should then be present with no leftover skull and can then be uploaded for reprocessing.

**Uploading Edited Files**

Once a scan has been edited and deemed ready for reprocessing, once again go to the computer through which the editing has taken place. It is necessary to communicate with the operating system through a “shell” or terminal window. In this case, we go to Ubuntu and open the terminal window.

The command we will run looks like:

```plaintext
fsupload <project> <MRsession>
```

This command will upload the file to XNAT and mark it to be rerun. It will be integrated into the file of the unedited scan in XNAT.

Once processed, the scan will once again be marked as “Needing QA.” After going through the QA procedure once again, the file can then either be marked as “Passed with Edits” or it may need further edits, at which the same process may be completed again.

If the file does need further editing, it is not necessary but useful to delete the old downloaded scan data and redownload the new reprocessed data before making further edits; this will show the new pial/white matter surface boundaries.
Appendix A: FreeSurfer QA Quick Guide

1. Browse to FreeSurfer run in XNAT
2. Click View Snapshots
3. If viewing results subsequent to manual edits, can load edited subject in fsview for comparison
4. Inspect ALL slices
5. Look for any non-brain included, brain excluded, or misclassified voxels
6. Specifically look for these common issues:
   a. meninges included in superior regions
   b. temporal lobe excluded
   c. non-brain included as cerebellum
   d. frontal lobe excluded
7. Record results
   a. On FreeSurfer Session page, click Edit
   b. If no problems, set Status to Passed (or Passed with Edits if this is a reprocessed subject), set date and click Submit
   c. If issues, set to Failed-needs reprocessing, enter problems in Notes (including orientation and slice number), set date and click Submit, then go to Editing section in Appendix B
Appendix B: FreeSurfer Editing Quick Guide

1. Download
   a. Open terminal
   b. `fsdownload <PROJECT> <SESSION>`
2. Open and prep
   a. `fsview <SESSION>`
   b. set view to 1x3 horizontal
   c. set contrast, zoom and pan
3. Edit brainmask
   a. highlight `brainmask` in volume list
   b. save a new file
      i. `File Save Volume as`
      ii. Browse to directory for currently loaded session
      iii. name `brainmask.edited.mgz`
   c. go to slice
      i. click orientation in top toolbar to switch between Axial, Coronal, Sagittal
      ii. use `Page Up/Page Down` to change slices
   d. erase/add voxels
      i. click `Voxel Edit` action
      ii. set Brush Size to 4 (smaller or larger as appropriate)
      iii. for erase
         1. set Brush value to 1 (this way we can erase without having to Shift-click)
         2. select Freehand tool
      iv. for add
         1. select Clone tool
         2. set Reference set to T1
      v. click and drag with smooth strokes (save often)
   e. Verify and Complete in other orientations and adjacent slices
   f. Final save: `File > Save Volume`
4. Edit control points
   a. click voxel, if intensity < 110, add control points, otherwise skip to `Edit wm` below
   b. Click `Point Sets > New Point Set`, name control.dat and select T1 as template
   c. Click to Add points, sparingly, at base of wm strands
   d. Click `File > Save Point Set As`, save to `<SUBJECT>/tmp/control.dat`
   e. Final Save Point Set As
5. Edit wm
   a. same as `Edit brainmask` except brush value is 255
6. Upload with fsupload
   a. `fsupload <PROJECT> <SESSION>`
   b. confirm that fsupload reports the correct files are uploaded
7. After reprocessing completes (12-24 hours), QA results
   a. Load reproc in XNAT
   b. Load edited with `fsview`
   c. Confirm corrections were successful
   d. Check that new problems weren’t created
   e. If problems remain, set QC status to `Failed-needs reprocessing`, and go to #1 above
   f. If good, set QC status to `Passed with edits` and delete local copy of subject’s data
Troubleshooting:

To reset your Freeview preferences run this command (useful if a toolbar gets hidden):

defaults delete edu.harvard.mgh.nmr.FreeView